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Getting Started

The Hive mapping software system is installed on both a laptop/desktop PC and an iPAQ PocketPC®. If your 
Yellowjacket/Hive order includes an iPAQ shipped from the BVS factory, Hive Site Surveyor software will 
be installed on your iPAQ in advance. If you should need to install or re-install Hive software on your iPAQ, 
simply use the supplied SD (Secure Digital) installation card in the SD slot of your iPAQ.

Hive PC software for your laptop or desktop is all contained on the included CD-ROM. Insert this CD-ROM 
into your PC and you will be prompted to install the Site Initiator and Site Investigator. If you wish to install 
the Site Supervisor onto your iPAQ from this CD-ROM, be sure your iPAQ is connected to your PC and 
ActiveSync is installed.

Hive Software CD-ROM

Hive
Insert SD card into the SD slot on the top of iPAQ
Tap on the “Start” icon on top left of screen
Tap on “Programs” in menu
Tap on the “File Explorer” folder
Choose “My Device”
Tap on “SD Card” or “Storage Card”
Tap on “install” executable
Choose Yellowjacket receiver and iPAQ model for
installation and tap on that “install” button

SD Card Installer

DATE:_______________

Hive Software SD card
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Yellowjacket / Hive Troubleshooting Setup Steps
STEP 1 
When you start the software and tap past the startup screen, what do you see for the firmware and 
serial number? 
XXXXXX and 0.00 Proceed to STEP 2 
Valid SN and FW Proceed to STEP 10 

STEP 2 
Do you have the AC adapter Y cable attached to the iPAQ and YJ base unit? 
YES Proceed to STEP 4 
NO Proceed to STEP 3 

STEP 3 
Plug in the Y power adapter to the iPAQ and base unit and power from an AC source. Does the 
software see a firmware number and serial number now? 
YES The batteries on the iPAQ or base unit are not fully charged. 
NO Proceed to STEP 4 

STEP 4 
Reset iPAQ by pushing the button on the bottom of iPAQ using stylus. Run the YJ software again. 
Does the unit respond with a valid serial number and firmware version? 
NO Proceed to STEP 5 

STEP 5 
How does the flash card serial cable attach to the base unit? 
RJ-11 connector Call BVS at 732-548-3737 for a cable upgrade 
Grommet (fixed) Proceed to STEP 6 

STEP 6 
Re-seat the flash card and reset the iPAQ again. Does the unit respond with a valid serial number and 
firmware version when running the software again? 
NO Proceed to STEP 7 

STEP 7 
Verify that the AC Y cable is firmly attached to the base unit. You should hear a click while feeling a 
little resistance. Was the cable firmly attached? 
YES Proceed to STEP 8 
NO Proceed to STEP 3 

STEP 8 
Verify that the iPAQ is firmly seated in its expansion pack through the large connector at the bottom 
of the iPAQ. When you remove the iPAQ and then re-seat it, do you hear and see a confirmation (on 
the iPAQ screen) that the expansion pack was recognized? 
YES Proceed to STEP 9 
NO Connection is not made with expansion pack. Reset iPAQ and proceed to STEP 9 when a 
connection is made. If no connection is ever made, proceed to STEP 10. 

STEP 9 
Reset iPAQ and try the software again. Do you see a valid serial number and firmware version? 
NO Proceed to STEP 10 

STEP 10 
Call BVS at 732-548-3737 for further technical support and/or an RMA.
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Hive Site Initiator User Manual

OVERVIEW
The Hive Site Initiator allows you to import an existing floor plan or campus. It also allows you
to add 2.4 and 5 GHz objects such as access points and interferers. Text can also be added to the floor plan. 
The site file is then saved for use with the BVS YellowJacket(Plus) system for performing site surveys. 
        
 

QUICK START
Creating a site file which is ready for use with the Site Supervisor on the YellowJacket (Plus) system 
requires the following steps. See the sections below for individual explanations. Hive can import any of 
the following file formats: Monochrome BMP, 16-bit color BMP, 256 color BMP, 24-bit BMP, GIF, ICO, TIF, 
JPG and PNG.

1. CREATE A SITE
2. SET THE DIMENSIONS FOR THE ASPECT RATIO
3. ADJUST SIZE OF FLOOR PLAN IF NECESSARY
4. ADD STATIC OBJECTS TO FLOOR PLAN IF NECESSARY
5. ADD CUSTOM IMAGES AS STATIC OBJECTS
6. ADD WALLS, WINDOWS, AND DOORS
7. SAVE SITE FILE

CREATE A SITE
1. Use FILE/NEW on the menu to create a new site file.  
2. Choose a floor plan from the popup window to use as a base for your site. You may use a .bmp,.jpg,.gif 
etc.

SET THE DIMENSIONS FOR THE ASPECT RATIO
1. Click the ruler icon in the toolbox. Look for a location on the site that you know the distance.
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2. Click on the first point of the measurement. A flag will mark the spot.
3. Click on the second point of the measurement.
4. Now enter the distance and units for the measurement.
5. Repeat steps 2 thru 4 for the second measurement. Make sure that the second measurement is in a dif-
ferent orientation from the first point.
6. The dimensions of the site are now set.

ADJUST THE SIZE OF THE FLOOR PLAN
           
At times it may become necessary to reduce the amount of space an image takes up in memory, especially 
when considering the iPAQ.

There are two types of image reduction available in Site Initiator. There are multiple algorithms used to 
achieve the reduction.

SCALING
Scaling the image reduces the size of the image while attempting to keep all of the features of the floor 
plan. In effect, the image is shrunk. Scaling the image can be done in different ways. 

Different interpolation modes for scaling the image are listed below. These modes use different techniques 
to determine how to reduce groups of pixels into one which is representative of the group.

Interpolation Modes

D is the destination image and S is the source image. Here are simple explanations of some of the inter-
polation modes. Trying all of the modes will give a better understanding of what changes the image will 
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incur.

Remember, the higher-quality reduction, the slower the process. The lower the quality, the faster the 
reduction.

Bicubic - D takes on a color value from a source matrix (S) based on a polynomial function.
Bilinear - D takes on an average of colors from the nearest region of S (for example, a 2x2 matrix)
High Quality Bicubic - D takes on a color value from a source matrix (S) based on a polynomial function.
Higher quality bicubic (will run slower)
High Quality Bilinear - D takes on an average of colors from the nearest region of S (higher quality than
simple Bilinear)
Nearest Neighbor - D simply takes on the color value of the nearest pixel in the source.

CROPPING
Cropping the image will clip off the part of an image not specified in the new dimensions of the image.

ADD STATIC OBJECTS

A number of static objects can be permanently added to the site. Inserting each type of object is explained 
in the following passages.

ADD AN ACCESS POINT        
Existing Access Points may be added to the floor plan to simply show their location. First, decide whether 
you want to represent an 802.11a, 802.11b, or 802.11g access point. Choose the icon from the toolbar 
with the correct letter on it (A,B,G). 

Now click on the part of the floor plan where you would like to represent the access point.

INSERT TEXT
1. Click on the text insertion button on the toolbox.
2. Click on the location where you wish to insert the text.
3. Enter the text.
4. Press OK.

MICROWAVE/DIRECTIONAL ANTENNA/2.4 GHz PHONE/COMPASS
Any of these objects may be placed on the floor plan. Simply click on the desired object. Then click on the 
floor plan where you wish the object to be placed.

ADD CUSTOM IMAGES AS STATIC OBJECTS
Any custom bitmap may be added to the floor plan. Click on the “IMG” icon on the top toolbar. Then choose 



an image file. Then click on the floor plan where you would like the image.

ADD WALLS, WINDOWS, AND DOORS
Additional walls, doors, and windows can be added to the floor plan.

WALLS
Click on the wall icon on the top toolbar. Then click where you would like the wall to begin. Then click on 
where you want the wall to end. A new wall has now been added to the floor plan.

DOORS
Click on the door on the top toolbar. Choose a single or double door using the appropriate icon. Then click 
on where you would like the doorway to begin. Then click on the other side of the new doorway.

NOTE: The doors will swing differently based on start and stop clicks. If the finishing click on the doorway 
had been the starting click, the door would then swing in the opposite direction.

WINDOWS
Similar to the procedure for doors and walls, click on the window icon on the top toolbar. Then click where 
you would like the window to begin. Then click on where you want the window to end. A new window has 
now been added to the floor plan.

SAVE THE SITE
1. Choose FILE/SAVE from the menu.
2. Enter a name for your site file.
3. You now have a site file to put on the HP iPAQ that is part of the YellowJacket system.

STATUS BAR (Bottom)
On the bottom of the screen are different statistics. They are the pixels/foot(meter) ratio.

MENUS
There are 5 submenus located in the main menu at the top of the screen.

The FILE submenu lets you open or save site files.
NEW creates a new site file.
OPEN opens an existing site file.
SAVE saves a site file under the previously saved filename.
SAVE AS saves a site file under a new filename.

The EDIT submenu has editing options.
UNDO lets you undo up to 3 previous edits to the site.

The OPTIONS submenu contains system options.
SHOW GRID overlays a grid of dots on top of the site. These dots are usually 1 foot apart.
 
The SCALE submenu contains scaling options (see “Adjust the size of the floor plan”)
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Bicubic
Bilinear
High
High Quality Bicubic
High Quality Bilinear
Low
Nearest Neighbor

The HELP submenu contains help options.
ABOUT pulls up the about box.

RULERS
The rulers along the vertical and horizontal planes of the site represent a scale of the site. These
are set using the ruler toolbox option.   

ZOOM MODES
There are four different modes for zooming in and out of the floor plan.

ZOOM IN
Click on the magnifying glass with the ‘+’ sign. Then create a zoom rectangle by clicking-and-holding on 
an area of the floor plan. Then drag the mouse (while holding down the mouse button) to the next point.

A dashed rectangle will appear. When the zoom rectangle is the appropriate size, release the mouse but-
ton. The floor plan will now be zoomed into that rectangle.

ZOOM OUT
Clicking on the magnifying glass with the ‘-‘ sign will reduce the image resolution by a factor of 2, thereby 
making the image zoom out.

FIT TO SCREEN
Clicking on this zoom mode will fit the vertical size to the screen and adjust the horizontal direction accord-
ingly to the current aspect ratio.

ACTUAL SIZE
Clicking on the ‘actual size’ icon will display the floor plan in its original size.
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Hive Site Supervisor User Manual

INTRODUCTION
The Hive Site Supervisor runs on the HP iPAQ PocketPC that is connected to a BVS YellowJacket(Plus) 
system. The Site Supervisor allows you to import a site file that was created using Site Initiator. You then 
use this file to walk around the site and collect survey points. These points create a data file of information 
on your 802.11b/a/g network.

The information is then saved back to the site file for use with the Site Investigator program on the PC. You 
can also zoom in and out on points, delete existing points, pull up survey information on any point, and 
scroll throughout the entire site by use of the stylus or joystick.

After installation of Site Supervisor, you should see one of these screens on your iPAQ when you run the 
Hive application. Be sure that your Yellowjacket receiver matches the software version installed (802.11a, 
802.11b or 802.11bg).

REGISTRATION CODE
The first time that Site Supervisor is run, a dialog box will show up asking for the registration code. This 
code is located on the paperwork you received from the factory. Each unit has its own registration code 
which is tied to the serial number.

It is very important that the iPAQ is connected to the YellowJacket when running the Hive application. Hive 
asks the hardware for its serial number. If it is not talking to the hardware, the registration code will not 
be verified and the application disabled.
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OPENING A SITE FILE
The first step in surveying data is opening a site file created with Site Initiator. Tap on the leftmost icon 
on the bottom of the application to open an existing site file. Decide whether or not to keep existing data 
points (if any) from a previous survey.

PLACING A DYNAMIC ACCESS POINT
Dynamic access points can be placed on the site to show their location. After placement, these access 
points can be made visible or invisible. Site Investigator will be able to show these access points as 
well.

To place an access point, press the ‘AP’ icon on the bottom toolbar. A message will appear asking for a tap 
on the floor plan. Tap on the location of the floor plan where you would like to represent an access point. 
An icon representing the dynamic access point will now be visible at that location.

To make access points visible or invisible, go to the options screen from the bottom toolbar. Select or 
deselect “SHOW ACCESS POINTS”.

START SURVEY          
After you have loaded a site into Supervisor, you are ready to begin surveying. Look for a location on the 
site to start your survey. This is accomplished by using the stylus with the scroll bars, the zoom buttons, 
and the joystick.
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Tap the screen to start a measurement. A new screen will appear for a few seconds showing the scan 
progress and the AP’s that are showing up during the scan.

When the scan is finished, a colored circle representing the strongest signal is displayed. For an 802.11b 
YellowJacket/Hive, an option for basing the color on signal/noise is available.

Proceed to the next point for your survey.

DELETING A MEASUREMENT POINT
If the current measurement point was struck in an incorrect location or by accident, it may be deleted by 
pressing and holding that data point on the survey with the stylus. An information screen will appear and 
include the DELETE option for this point.

WALK/DRIVE PATH
If the option is selected using the option dialog from the bottom toolbar, a dashed line will show up 
between points on the survey.

This dashed line represents the the walked/driven path for the survey.

COMPLETE SURVEY
When you have covered the entire site with survey point, press the second icon from the left on the bottom 
of the screen. This will save the site file and its data points. You can now transfer the file back to the PC 
for use with Site Investigator!

INFORMATION SCREEN
Press and hold on any point in the survey with the stylus. This will pull up an information screen for that 
survey point.



This screen shows all of the MAC addresses that were seen during the scan of this point. Information such 
as channel number, SSID, and RSSI are displayed.

For an 802.11b system, an option to show signal/noise instead of RSSI is available.

SIGNAL/NOISE READINGS (B ONLY)
On 802.11b units, the signal/noise ratio is calculated when possible on the scanned points. The option 
dialog has an option to show RSSI or signal/noise in the color of the scan circle and in the information 
screen.
  

BOTTOM MENU
There are 9 menu items located in the main menu at the bottom of the screen.

Open a Site File
This option will prompt for an existing site file which had been previously created using Site Initiator.

Save a Site File
This option will prompt to save the current site and surveyed data to a filename of your choice.

JPEG Snapshot
This option will take a snapshot of the current screen. You will be prompted to save the snapshot to a JPEG 
filename (as in digital cameras).

Zoom Into the Site
Pressing on this option will increase the magnification of the site by a factor of 2.

Zoom Away from the Site
Pressing on this option will reduce the magnification of the site by a factor of 2.

Dynamic Access Point Placement
A message will appear asking for a tap on the floor plan. Tap on the location of the floor plan where you 
would like to represent an access point. An icon representing the dynamic access point will now be visible 
at that location.
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Application Options
This option brings you to a dialog containing various options represented by check boxes or radio but-
tons.

These options include :

- Whether or not to display dynamic access points
- Whether or not to display the walk/drive path
- (B only) Whether to display the color circles and information point values based on RSSI or signal/
noise.

Application Help
This option brings you to a list box containing a synopsis of help for the Site Supervisor.

About Hive
Standard application about box with version and copyright information.

Scroll Bars
The scroll bars aid in navigating throughout the site.

Joystick
The joystick on the Ipaq can be used to navigate throughout the site. Pressing the joystick dead on the 
middle results in a survey point at the location of the cursor. Use the left, right, up and down options on 
the joystick to maneuver around the site.

SURVEYING TIPS
In order for the site Investigator to be effective, enough points must be taken so that a clear picture of site 
coverage is given. The radius size for points in the Site Investigator is 10 feet.

Taking points within this radius is recommended. Obviously, the more points, the better the reporting will 
be in Investigator. For example, a typical 20x20 office could use at least 4 points.

RULERS
Hive also has vertical and horizontal rulers which show the physical dimensions of the site.

GREEN INFORMATION BAR
This information bar above the scroll bar shows the zoom factor and the total number of scans and total 
number of MAC addresses (including multiples).
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Hive Site Investigator User Manual

Hive Site Investigator the analysis component of the Yellow Jacket Hive software package for Wireless 
Local Area Networks (WLAN).  It provides analysis of coverage, interference, channel reuse and more.

Getting started with Hive Site Investigator
Hive Site Investigator uses data recorded with Hive Site Surveyor.  Hive Site Surveyor produces a Hive Site 
Survey file (*.hss) that contains the collected data and the floor plan.  

Hive Site Investigator is project based.  To begin using Hive Site Investigator a new project must be cre-
ated.  Each project is based on a Hive Site Survey file. However, any number of projects may be based on 
a single site file.  To create a new project, select New Project off of the File menu.

The Hive Site Survey file selection dialog then appears.

In the Hive Site Survey file selection dialog, press the Select button and browse for the *.hss file to base 
the project on.  The project window will then appear. 
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The left pane of the project window contains the controls window and the right contains the floor plan.

Saving a Hive Site Project File
At anytime after a project has been created it can be saved to a file.  The current settings, state of controls 
and graph (floor plan and analysis) are saved in a project file and can be recalled later.  To save a project, 
select Save or Save as… off of the File menu.  
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If the project has previously been saved, the Save option will overwrite the existing file, while the Save 
as… will allow a new file name to be selected.

Opening an Existing Hive Site Project
To open an existing Hive Site Project select Open Existing Project from the File menu.  A Dialog will appear 
to allow selection of the project file (*.hsp) to open.  Note that project files from earlier versions of Hive 
cannot be opened in this version, but new projects can be based on the Hive Site Survey files from older 
versions of the software.

Selecting APs for Graphing
Before graphing, Access Points (APs) or groups of APs must be selected.  Selections are made in the 
Controls Window.

The AP Selection tool contains a list of all APs that are present in the Site Survey file.  Checking the box 
next to the MAC address includes the AP in the analysis.  The APs can be sorted and grouped my SSID or 
by Channel using the radio buttons at the top of the window.  
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The color indicator between the MAC address and the check box has two functions.  One is to select the 
color used to graph signal strength or signal to noise data from that AP (or group).  The other is to select 
how APs are grouped for analysis.  Clicking on the space between the group label (SSID or Channel) and 
the check box will move the indicators to the groups. Left clicking on the indicator will toggle individual 
mode and Combined mode.  These conditions are explained graphically in the following table.

Example Grouping Description
Individual Each selected AP is 

graphed in its own color 
indicated by the color of 
the star

Group 
Selection by 
SSID

The best coverage for 
each SSID is shown using 
the APs selected.

Group 
Selection by 
Channel

The best coverage for 
each channel is shown 
using the APs selected.

Combined 
Selection

The coverage of the APs 
selected is combined and 
graphed in a single color.

To change the color for a selection, right click on the color indicator.  A color selection dialog will 
appear.

Selecting Coverage or Overlap Analysis
Buttons for selecting Coverage and Overlap Analysis appear at the bottom of the Control Window.

The two overlap buttons, , select the type of analysis.  When both buttons are out (unselected), 
coverage analysis is used and the signal strength or signal to noise is graphed.  When the cochannel over-
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lap button is depressed (selected), coverage areas of APs or groups of APs that overlap on interfering RF 
channels are graphed.  When the overlap button is depressed (selected), coverage areas of APs or groups 
of APs that overlap are graphed, regardless of RF channel.

Range Control
The Range Control, shown below, controls how the signal strength is represented on the graph.  If the 
signal to noise button is selected, for files that contain signal to noise data, the control values will appear 
in dB instead of dBm.

The two sliders set the minimum and maximum values for the graphing range.  In the overlap modes, the 
minimum setting determines the minimum signal strength for an area to be considered as having cover-
age.

Resolution Control
The resolution control shows the size of the points calculated.  Set the control for larger points will speed 
up the calculation at the cost of resolution.  Typically, this control is set to speed up calculations while 
setting up graphs and the distance is reduced again before the final graphs are made. The button resets 
the control to a reasonable default setting.

Walk Path
The Walk Path shows or hides the walk path.  The walk path connects the point in the order they were 
recorded in surveyor and indicates the direction.  A green circle indicates the first point and a red circle 
indicates the last.  See the following example.
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Signature Button
The signature button displays a box with the signature that was recorded when the site file was saved.

Advanced Options
The Advanced Options button displays the Advance Options Dialog.  The maximum valid distance is cur-
rently the only setting in this dialog.
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Controlling the View
The mouse wheel can be used to zoom in and out of the graph view.  In addition there are several hot but-
tons available to change the zoom of the graph view.

Button Name Description

Zoom Tool

After clicking this hot button, the cursor chang-
es to a magnifying glass.  Left clicking on the 
image zooms into that point.  Right clicking on 
the image zooms out from that point.  Clicking 
on the hot key again turns off zoom mode.

Fit to Window
Pressing this hot key fits the image to the cur-
rent size of the graph window.

Original Size Restores the image to the original size.

Measuring Distances

Distance measurements can be made on a graph by using the ruler tool, . To mea-
sure distances, select “Measure Distances” on the action menu or use the hotkey.

Left click and hold on the graph to start the measurement. As the mouse moves, distance is displayed in 
the lower right corner of the window.

 

Saving Coverage Graph
The current coverage graph can be saved as a bitmap.  Select Save Graph Image... off of the File menu.
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Table View
To view the data point in tabular form, select Table Window off of the Window menu.

An example of a table view follows.



 

To save the table in a form that can be used by spreadsheet applications and other programs, select Save 
Table as… off of the File menu.  The save table options dialog then appears.

The output is an ASCII file that can be customized for easier conversion to a specific program.  

Printing
The standard Windows printing selections, Print…, Print Preview and Print Setup…, are available on the 
File menu.
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In addition, the Print to RTF File… selection is also available.  An RTF file contains both text and graphics 
and is importable into almost all word processing software.  RTF files can be very large, when compared to 
the internal format of most word processors.  These files may take a long time to generate and load. Fonts 
for printing, both on a printer and in a RTF file, can be selected with the application options.  Selecting 
Options on the Tools menu will bring up the Application Options dialog.
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Printing the Hive Site Investigator project, prints general information about the state of the graph, such as 
the selections in effect, the graph image and a legend for the image.  An example follows.
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Hive Site Survey File Information:
   File Name: 1floor1.hss
   File Version: 2.0
   Survey Time: Monday, March 07, 2005 16:21:24

Graph Information:
   Graph Type: Coverage for Selected SSIDs
   Number of Data Points: 188
   Resolution:    2.0 feet
   Minimum Valid Point Distance:   10.0 feet
   Signal Strength Range: -100 dBm through -30 dBm
   Walk Path: Not Shown
   AP Markers: None
   Time Graphed: Monday, April 11, 2005 16:57:13
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Legend

 SSID: “Wireless”
       00-40-33-AF-F2-01 channel:  1 SSID: Wireless
       00-40-33-AF-F1-C3 channel:  8 SSID: Wireless
       00-40-33-AF-C5-A3 channel: 10 SSID: Wireless

 SSID: “BVS”
       00-0F-3D-05-CB-0B channel:  6 SSID: BVS

 SSID: “copper”
       00-0F-34-46-BA-6C channel:  1 SSID: copper
       00-0F-34-46-BA-9E channel: 11 SSID: copper
       00-0F-34-46-BA-A6 channel: 11 SSID: copper
       00-0F-34-46-BA-1D channel:  1 SSID: copper

 SSID: “linksys”
                00-0C-41-DC-4E-F0 channel:  6 SSID: linksys
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Call us today for more information on Hive software:
(732) 548-3737 / Fax: (732) 548-3404
Internet: www.bvsystems.com
E-mail: info@bvsystems.com

Create floorplans from scratch or from any BMP, GIF, JPEG, TIF

User defined objects for placement onto floorplan

Import existing floorplans for modification and surveys

               BERKELEY
       VARITRONICS
SYSTEMS

wireless products
Windows CE, PocketPC and HP iPAQ are  registered ® trademarks of the Microsoft Corporation and Hewlett Packard Corporation respectively.

HiveTM

Touch-screen measurement points using PocketPC®

Customizable surveys based on MAC, RSSI, SSID

Take floorplan survey snapshots anytime

Visible survey path throughout floorplan

Auto-save after every measurement point taken

Hive™ is powerful mapping software that works with 
Berkeley’s Yellowjacket® 802.11 (B, A or B/G) Wi-Fi receiver 
system. Hive™ runs on an iPAQ® Pocket PC® allowing site 
surveys to be handheld and performed completely INDOORS 
or outdoors using real-time mapping coverage technology. No 
GPS reception needed. First, import bitmap files into Hive™  
Site Initiator and scale your rooms and walls for measurement 
overlays. Walk through an office space, warehouse or multi-
floor building - any interior space that needs to be surveyed 
- and take Access Point measurements with Site Supervisor. 
Then place those measurements on top of any structural floor-
plan to get a comprehensive, bird’s eye view of any WLAN 
based upon MAC addresses, RSSI, SSID and more. Finally, 
view your Wi-Fi coverage results in table and graphical views 
using Site Investigator running under Windows 2000 and XP.

Create your floorplan:

Take your AP measurements:

Site Investigator:
Plot and view surveys in multiple data table or graphical windows

Plot coverage by AP or AP groups

Print and export plots or table data into ASCII format for spreadsheets

Create RTF files that import into MS Word & most popular word processors

Organize and plot your coverage:

1

3

2

Survey floorplans on 
a PocketPC. Create 
and organize survey 
maps on a PC.

Site Initiator

Site Supervisor

802.11b802.11a
802.11g

Yellowjacket® Indoor 802.11 Wi-Fi Mapping Software
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